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Setting Up Your Web Browser

In order to allow the Gale Usage web portal to interact fully with your web browser, you may need to
make some changes to your browser settings. This will allow the portal to open pop-up windows and
download reports without changing the way the browser functions on other web sites.

Internet Explorer

Disable the IE Pop-Up Blocker When On the Portal

1. From the menu, select Tools->Internet Options
(Note, if you don’t see the menu, you may need to press the Alt key to display it)

2. Select the Privacy tab

eneral | Security F‘rivac';.f[%C

3. If the pop-up blocker is not turned on, you don’t have to do anything else and can click the
Cancel button.

Pop-up Blocker
|— 1| Prevent most pop-up windows Fram
- appearing.

I [ ] Turn on Pop-up Blocker I

4. |If the IE pop-up blocker is turned on, click the Settings button.

Pop-up Blacker

| il Prevent most pop-up windows from Settings
- appearing.

Turn on Pop-up Blocker

5. Inthe Address box, enter the site usagereports.galegroup.com and click the Add button

Exceptions

Pop-upz are currently blocked. You can allow pop-ups from specific
~ 7! websites by adding the site to the list below.

Addresz of website o allow:
uzagereparts. galegroup. con Add




6. Click Close to save your changes

[#] Pop-up Blocker Settings [#]

Exceptions
Pop-ups are currently blacked. “You can alow pop-ups from specific
2! wehsites by adding the site to the list below
Address of website to allow:
Allowed sites:
galegroup.com

M atifications and filker lewvel
Flay a sound when a pop-up iz blocked.
Show Infarmation B ar when a pop-up is blocked.

Filter level:
Custom v
Pop-up Blocker FAQ

7. Click OK to close Internet Options

Make the Portal a Trusted Web Site

1. From the menu, select Tools->Internet Options

(Note, if you don’t see the menu, you may need to press the Alt key to display it)

2. Click on the Security tab

General Security%

3. Click on the Trusted sites icon and click the Sites button

General | Security | Privacy | Content

Connections | Programs | Advanced

Select a zone to view or change security settings,

@ €« v O

Internet Local intranet  Trusted sites  Restricked

sites
Trusted sites

Sk
4 This zone conkains wehsites that you

v trust not ko damage your computer or
waour Files,

¥ou have websites in this zone.

If the Require server verification box is checked, click it to un-check it.
I__[;%Qequire server vetification (htkps: ) For all sikes in this zone




5. Inthe website box, enter http://usagereports.galegroup.com, and click the Add button

Add this website to the zone:
| htkp: ffusagereports. galegroup. com | [ Add %J

6. Click the Close button to save your change.

Trusted sites fgl

¥ou can add and remave websites from this zone. All websites in
b this zone will use the zone's security settings.

&dd this website ta the zone:

Websites:
2group, COom Remove

[Jrequire server verification thttps:) For all sites in this zone

7. Click on the Custom level button

Internet Options

General| Security |Privacy Content | Connections | Programs || Advanced

Select a zone ko wiew or change security settings,

@ @ v O

Internet Localintranet  Trusted sites  Restricted
sites

Trusted sites
J This zone contains websites that wou
h trust nok to damage your computer or

waur Files,
¥ou have websites in this zone.

Security level for Ehis zone

Custom
Cuskom settings.
- To change the settings, dick Custom level,
- To use the recommended settings, click Default lewvel.

[ Customlevel...%[ Default level ]

[ Reset all zones to default level ]

[ QK ] [ Cancel




Scroll down to the ActiveX controls and plug-ins section and enable the Binary and script
behaviors, Run ActiveX controls and plug-ins and Script ActiveX controls marked safe for
scripting options.

ActiveX controls and plug-ins > Binary and script behaviors

Security Settings - Trusted Sites Zone [‘57\

sgttm’gf’-__.._____‘\

- |#| Binary and script behaviars
) administrator approved
(O Disable
(%) Enahle

] imation on a webpage that does nak use =
(%) Disable
O Enable
|| Download signed ActiveX controls
() Disable
() Enable
@ Prompk
|#| Download unsigned Activer controls
(%) Disable
() Enable
O Prompk be,

4 Trikizlina and crvink febivay combeale rok rnavkad ae cofa Fae oo

3 | >

*Takes effect after vou restart Internet Explorer

Reset customn setkings

RBesettor | medium (default) v | [ Rgset... ]

[ Ok ] [ Cancel ]

ActiveX controls and plug-ins > Run ActiveX controls and plug-ins, Script ActiveX controls marked safe for scripting

Security Settings - Trusted Sites Zone rz|

Settings/__'\

9] Run Activex controls and plug-ins
() Administrator approved
) Disable
(3) Enable
O Prompt
|#] Scripk Activel controls marked safe for scripting®
() Disable
(%) Enable

|

.93 Automatic prompting For file downloads
() Disable
(%) Enable

,9‘2 File download

() Disable
(3 Erzhla
< | >

*Takes effect after you restart Internet Explarer

£

Reset cuskomn setkings

Reset to: |Medium(default) V| l Reset... ]

[ Ok I [ Cancel ]




9. Scroll down to the Downloads section and enable the Automatic prompting for file downloads
and File download options.

Security Settings - Trusted Sites Zone rg|

Settings

S

L wnloads
.93 Automatic prompting For file downloads
) Disable
(%) Enable
.93 File: download
) Disable

© EE

ES
() Disable
(®) Enable
O Prompk
,93 Enable .MET Framewark setup
() Disable
(&) Enable
& Miscellaneous

| Nerace Aaba criwear acvace daraaine

£ | ¥

|

|£

*Takes effect after you restart Internet Explarer

Reset custorn setkings

Resstbad | Madium (default) b | [ Reset... ]

[ oK %" [ Cancel ]

10. Scroll down to the Miscellaneous section and enable the Allow META REFRESH option.

Security Settings - Trusted Sites Zone r5_<|

Settings

& Miscellaneous
&) Access data sources across domains
(%) Disable
) Enable

|3

& Allow META REFRESH
() Disable
(®) Enable

ernet Explorer web browser contral

(%) Disable

O Enable

g‘ Allows script-initiabed windows without size or position constre
(%) Disable
O Enable

& Allow webpages to use restricted protocols for active conten
™ Micshla ¥
< | >

*Takes effect after you restart Internet Explorer

Reset cuskomn setkings

Bessttor | Medium (default) v | [ Rgset... ]

[ Ok I [ Cancel ]




11. Scroll down to the Scripting section and enable the Active scripting and Allow programmatic
clipboard access options.

Security Settings - Trusted Sites Zone g|

Settings/.-"'"_‘\
%cripting
| Active scripting

() Disable

(®) Enable

O Prompt
& Allows Programmatic dipbnard access
O Disable
(%) Enable
Prompt

o

7| Alle
) Disable
(%) Enable
| Allow websites ta prompt For information using scripbed winde
() Disable
(®) Enable

= Cevinkinn oF Tz snnlabe

< >

*Takes effect after you restart Internet Explorer

& scripk

Reset cuskomn setkings

Reset to: |Medium(default) V| l Reset... ]

[ OK I [ Cancel ]

12. Click OK to confirm the custom security settings for trusted sites.
13. Click OK to close the Internet Options window.

14. Restart Internet Explorer if prompted to do so.



Firefox

Disable the Firefox Pop-Up Blocker When On the Portal
1. From the menu, select Tools->Options
2. Click the Content icon.
=,
=
Cankent

3. If Block pop-up windows is not checked, you don’t have to do anything else and can click the
Cancel button.

[ Block pop-up windows:

4. If Block pop-up windows is checked, click the Exceptions button.

[]: Block pop-up windows: Exceptions. N

5. Inthe Address box, enter the site usagereports.galegroup.com and click the Allow button.

Address of web site:

usagereparts, galegroup.com

6. Click the Close button to save your change.

) [#] Allowed Sites - Pop-ups [#] CEX

Yo can specify which web sites are allowed to open pop-up windows. Type
the exact address of the site wou want to allow and then click Allow,

Address of weh site:

Site: Status
usagereports,galegroup, com Allow

[&Bmove Site: ] [Rgmove All Sites ]

7. Click OK to close the Options window.

Add-In Pop-Up Blockers

If you are using any pop up blockers (such as those included with popular add-ins like the Google or
Yahoo toolbars), you will either need to disable them when you are on the Gale Usage portal, or set
them to allow pop-ups for usagereports.galegroup.com.

Refer to your individual pop-up blocker’s documentation or help for directions on how to do this.
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Gale Usage Web Portal

System Availability

The Gale Usage web portal is available from 12:00 AM to 11:00 PM Eastern time, 7 days a week. Please

do not log in to the system or schedule reports to run during the nightly maintenance window.

Update Schedule

The portal is updated daily. Usage data is 3 days in arrears of the current calendar date.

Logging In

1. Using either Microsoft Internet Explorer or the Firefox browser, navigate to the address:

http://usagereports.galegroup.com/cognos8

2. Atthe log on page, enter your portal User ID and Password and click the OK.

Note: If you don’t know your User ID/Password, e-mail Gale Technical Support at
gale.technicalsupport@cengage.com or call 1-800-877-4253 Option 4.

& Log on - Windows Internet Explorer

@\ = | &) hipijusagereports galegroup. comfengnossje v || ¢ | X |

Fie Edit view Favorites Tools  Help

@ - b B - ® - W e © @ -
S - » Eoee B &

W & | @ioaon [ ] G- B @ - Eeme-

Please type your credentials for authentication.

User ID:
gal_0004/galeuser

Password:

cancel Copyright (C) 2008 Cognos ULC, an 16V Campany. Allrights reserved.
& Cognos (R)is & trademark of Cognos ULC, (formerly Cognos Incorporated).

fcoanossfeqi-binicognos. cgi J Trusted sites 100 v

3. This will open the Gale Usage portal.

11



Elements of the Portal

~% GALE
i» CENGAGE Learning

B o
@Gale Customer Reports O My Folders a
e
E=]

Gale Customer Reports

Click on any of the reports below to view you sage
QCustomer Reports = B

N _/

| Name $
fFl»  COUNTER - Book Report 2 (R1)
FAP COUMTER - Database Report 1 (R2)
AP COUMTER - Database Report 2 (R2)
FAP  COUMTER - Database Report 3 (R2)
fAP  COUMTER - Joumnal Report 1 (R2)
@lp  Gale - EBook Retrievals
[@lp  Gale - Journal Retriev:

Actions Legend

.:‘3,
‘3—

Displays the properties of the report

B

J Runs the report with options

Bf Creates a "Report View" of the report
which you can save into "MY Folders"

vals

[@]p Gale - Usage by Database

[@lp  Gale - Uszge by Location, Date, and Time
[@]p Gale - Usage by Session Time

[@lp  Gale - Usage Summary

i)

in your "My Folders tab

[ig

N NV VIV VVVYWY

)

1. User Name

This value also appears in the headers of the standard reports. It also appears in the Counter
reports when output as HTML, PDF, or Excel (not CSV or XML)

2. Log Off

Log Off

Click this ling to log off of the portal and prevent unauthorized access.

3. Search

1IN

Search for reports by name. Useful if you have a many report views saved in My Folders.

4. User Menu

My Ackivities and Schedules

a. My Activities and Schedules
Allows you to see reports you have scheduled as well as the status of reports that are
running now or that have been run by you in the past.

5. Gale Customer Reports tab

Gale Customer Reports l

This contains the standard reports that are available to you. You can make no changes to the
reports in this tab.

12



6.

10.

11.

12.

13.

My Folders tab

My Folders

This contains any report views you have saved. These report views can have prompts saved and
can be scheduled to run recurrently.

Default output type
a. = Reports with this icon are output as Microsoft Excel files.

b. - Reports with this icon are output as HTML, viewable in your web browser.

Report Name

Name &

COUNTER - Book Report 2 (R 1]
COUNTER. - Database Report 5 12)

a. Inthe Gale Customer Reports tab, clicking on the name of the report will run the report.
b. Inthe My Folders tab, clicking on the name of the report will open the last report you
have saved. If you have no saved reports, it will run the report.

Report Properties link

&

Click on this link to view the properties of the report.
a. Inthe Gale Customer Reports tab, you can make no changes to these properties.
b. Inthe My folders tab, the properties can be changed.

Run With Options link

4

Click on this link to change the output format of the report before running it.

Create a Report View link
B

Click this link to create a report view which can be saved in My Folders.

Schedule Report link

a. Inthe Gale Customer Reports tab, this link is disabled
b. Inthe My Folders tab, this link allows you to schedule the report to be run later. Items in
the My Folders tab can also be scheduled to run on a recurring basis.

More options link
Mare...

This link opens a window allowing you to access additional options.

13



Available actions:

Set properties

P Run with options. ..

Ed  View the schedule

@ Create a shortout to this entry...
E?f Create a report view of this report...
Add to bookmarks...

Cancel

Most of the options in this window can also be accessed from icons in the portal as discussed
above. There are two options that can only be accessed from this window:
a. Create a shortcut to this entry
Similar to creating a Report View, except that it cannot contain any properties of its
own, so it can’t be scheduled, and prompts cannot be saved.
b. Add to bookmarks
Allows you to save the report to the Bookmarks or Favorites of your web browser.

14



My Activities and Schedules
To view the history of reports you have run and the reports you have scheduled to run in the future,

click on the User Options link and select My Activities and Schedules from the drop-down menu.

My Activities and Schedules

Elements of the My Activities and Schedules screen.

My Activities and Schedules

BN Current Activities @

m. Past Activities @
m Upcomin: .ﬂcﬁvities@
Schedules @

Status:
&)
Priority:

[any ] (5)

Advanced options ¥
Reset to default @

Gale Customer Log DFF B n * = @v launch ~ 7 =

Current Activities

o I m

Total (1) /

Pending | O @
Executing 1 @

S ®HOO W
Suspended | O :

[i] 5 10 15
Entries: - o

O] |Mame | Request time & | Status & | Priority 2

F COUNTER - Journal Report 1(R2) ~  April 7, 2009 3:11:08 PM Executing 3

Last refresh time: Aprl 7, 2009 3:11:15 PM

1. Current Activities

Lists any reports that are running or queued to run. This does not include reports that were run

interactively.

2. Past Activities

Lists the history of reports that were previously run, excluding reports that were run

interactively.

3. Upcoming Activities

Lists the reports that are scheduled to run for any given day in the future.

4. Schedules

Lists your scheduled reports and allows you to modify them.

15



5. Status filter
Status:

Any

Enabled
Disabled

Allows you to filter the list by status. The available status values will vary depending on what you
are viewing:

a. Current Activities
e Any
e Pending — Queued to run
e Executing — Currently running
e Waiting - Waiting for a process external to IBM Cognos 8 to complete
e Suspended — Manually put on hold
b. Past Activities
e Any
e Succeeded — Ran successfully
e Failed — Ran, but failed with an error
e Cancelled — Manually cancelled
c. Upcoming Activities
e Any
e Scheduled — Scheduled to run in the future
e Cancelled — Manually Cancelled
d. Schedules
e Any
e Enabled — Schedule is enabled
e Disabled — Schedule is disabled and will not run.

6. Priority filter
All of your reports should have a priority of 3, so this filter should always be left at its default.

7. Advanced options
This provides you with filter options that will be not be useful to you and should be ignored.

8. Reset to default
Click this link to reset all of the filters to their default values.

9. Summary

Lists a summary of the filtered objects in the list below. The values in this will vary depending on
what you are viewing. The values will match those in the status filter above.

16



10.

11.

12.

13.

14.

15.

16.

Show details
Click this icon to show details in the list below.

Hide details
Click this icon to hide details in the list below.

The remaining icons in the tool bar may vary based on what you are viewing
Cancel

Cancels all reports you have selected () in the list below.

Suspend

Suspends (puts on hold) all reports you have selected () in the list below. Reports that are
currently executing cannot be put on hold.

Release

Releases any suspended reports you have selected () in the list below.

Return

Returns you to the Gale Extranet portal.

Report List
List reports based on your selections in the panes to the left. You can see additional options for

each listed report by clicking on the Actions icon (IEI) to the right of the report name.

17



Report Run Options

Format:
HTML =

Language:
English (United States)

Delivery:
@ View the report now
() Print the report:
Printer location:

Prompt values:
No values saved

Prompt for values

2. To specify a time to run the report, or for
\J- additional formats, languages, or delivery

tj options, use advanced options.

Select a printer...

HTML — This is the default format for all of the Gale standard reports. The HTML format opens
the report in your web browser and is best suited to short reports that you wish to view

By default, reports that are run in HTML will show 100 lines of data per page and the pages can
be navigated using the page navigation links at the bottom of the page
(= Top & Page up ¥ Page down = Bottom), The number of lines displayed per page can be modified

PDF — Reports run in PDF format must be viewed using the Adobe Acrobat PDF reader (or a
compatible substitute). This is the recommended format if you intend to print the report.

Excel 2007 — Reports generated in this format are compatible with Microsoft Excel version 2007
or higher. This format is best if you wish to add your own calculations to the report.

Users with older versions of Excel can download a free conversion utility from Microsoft:
http://office.microsoft.com/en-us/products/hal01686761033.aspx.

Run Cancel
Format
[ ]
immediately.
by using Advanced Options.
[ ]
[ ]
[ ]

Excel 2002 — Reports generated in this format can be opened in Microsoft Excel versions 2002

and higher (including Excel 2007) as well as Microsoft Internet Explorer. This does not actually

generate an Excel spreadsheet because of the potential for files in the older Excel format to be
infected with macro viruses. The actual format of the generated file is MHTML.

When running the report interactively, the MHTML file is saved with an extension of “.xIs” so
that Microsoft Excel will open the report by default. However, many email systems will block
files with the “.xIs” extension, so if the report is emailed, the file will be delivered with an “.mht”
extension.

18



Issues with the Excel 2002 (MHTML) format.

0 How to open an MHTML file in Excel:
By default, Windows will open files with an extension of “.mht” in Internet Explorer.
Once the file is open in IE, simply select File -> Save as and save the file as a Microsoft
Excel Workbook. You can then open the saved file in Excel.

0 If the MHTML file name ends with an “.xIs” extension (by running the report
interactively or by renaming the file manually) and you try to open it in Excel, some
versions of Excel may give you a warning similar to this one:

Microsoft Office Excel

P\ The file yau are trying ko open, 'CHSd4CECd+v4d4dGisCohjaMaMwwyyylvMhCijyl I, isin a different format than speafied by the file extension.
Werify that the file is not corrupted and is from a trusted source before opening the file, Do you want to open the file now?

[Yes][NolIHe\p]

Mitas this information helpful?

This is to advise you that the MHTML file has an extension that doesn’t match the

format. If you get this warning, simply click the Yes button.

e (CSV - Comma Separated Values. This format delivers your report as a plain text file with a
comma between each value.

Unlike HTML, PDF, and Excel formats, CSV files contain the data without report headers and
footers. CSV format is best suited when you wish to open it in a spreadsheet other than
Microsoft Excel.

Note: CSV format is not available for the Usage Summary report

e XML - Short for eXtensible Markup Language, this is a text file with XML tags to identify each
value.

Unlike the CSV format, XML files contain the data without report headers and footers.
Please note that COUNTER reports saved in XML format do not comply with recently adopted
COUNTER standards for XML reports.

Note: XML format is not available for the Usage Summary report

Language
This feature is not currently being used. All reports are generated in English only.

Delivery
e View the report now

0 If the format you selected is HTML or PDF, the report will be displayed in a browser
window.



0 All other formats (Excel 2007, Excel 2002, CSV, and XML) will allow you to save the file to
your hard drive.

e Print the Report
This feature is not enabled. If you wish to print the report, select PDF format and then print the
report from your PDF viewer.

Prompt Values

If No values saved is displayed (as will always be the case when running a report from the Gale
Customer Reports tab), you must leave this box checked. If you try to run the report without specifying
the report prompts, the report will not run correctly.

If there are prompt values saved (which can only happen for report views in your My Folders tab), you
can uncheck this box to use the saved prompts, or check this box to run the report with new prompt

values.

20



Common Report Prompts
These are some of the most common report prompts you will find in the reports.

Date Selection prompt

Dats available from January 1, 2007 through April 4, 2009

Date Se\ectmn:|* |Last Month

Date Selection

Last Year
This Quarter

Date Range
This Year

Last Quarter
This Manth

=] This allows you to run the report for a relative date range (ex: all of
Last Month), or you can select Date Range which allows you to use
the Date Range prompt to select a specific date range.

Most reports default to running for Last Month.

The top of the Date Selection prompt shows you the date range for
which data is currently available. There is typically a two or three-day delay before data will be available
(ex: on April 6, you should be able to see data up to and including April 4).

If your date selection falls outside of this date range, you will see a warning in the report header. This
warning is only available when the report format is HTML, PDF, Excel 2007, or Excel 2002 (i.e. not CSV or

XML).

Date Range prompt

Date Range:|

Mote: This prompt is ignored|
unless "Date Range” is chosenit .
as the Date Selection above| P

Jul

Jan

Sun Mon Tue Wed Thu Fri Sat

B
&
RE
E
E

2009 »
Feb Mar Apr May Jun
Aug Sep Oct Mov Dec

18
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Database Selection prompt

Databases:

Optional: If no value is
selected, all databases will bej
included.

ote: To select multiple values,|
hald the Ctrl key whild clicking
items.

17th and 18th Century Burney i‘
19th Century British Library Me
19th Century UK Periodicals
Academic ASAP

Academic OneFile

Advanced Placement Fine Arts
Advanced Placement Global Hi:
Advanced Placement Governmi
Advanced Placement Honors Li
Advanced Placement Psycholoc
Advanced Placement Science Ej

Select all Deselect all

This prompt is only used when Date Range is selected in the Date
Selection prompt. If any of the relative dates are selected in that
i e prompt, the Date Range prompt is ignored.

The Database Selection prompt lets you choose which
databases you want included in the report. By default, all
databases are included. Use this prompt only if you wish
to limit the report to specific databases.
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Location Selection prompt

Tomtion Salecion | ovatons (Gl vt 1o selord) 3 The Location Selection prompt lets you choose the location, or

Lacation Selection

locations that you want included in the report.

Gale Customer (Consortia ld: Exmpl)
Library Types (Click Next to select)

Libraries (Click Next to select
Locations (Click Next to select

will be specific to each user and includes all of the locations available to the user. In the above example,

The first option will always be the default value. The description

the user can access all locations under the location “Gale Customer” (with a consortium id of “Exmpl”).
If this first option is selected, you do not need to go to the second prompt screen.

The remaining options will vary for each user depending on the locations they have available to them. If
you select any of these options, you will need to click the Next button to see the selected prompt.

e Library Types
If you have access to multiple library types, this option will be available.

e Llibraries
If you have access to multiple libraries, this option will be available.

e locations
If you have access to multiple locations, this option will be available.

If you select any of the above three options, remember to click the Next button at the bottom of
the prompt page.

Library Types prompt

If you selected Library Types in the Location Selection prompt (and clicked
Usage Summary

Report Selaction Criterz (confinuec) Next), you will be presented with the Library Types prompt.
e Note: this prompt is not available for the Counter reports.
[CIen-Profit
Library [CNot Specified . . . .
Irypes: Dleubiic This lists the available library types.
[[]5chool
[Special
s peseecdl || Some reports will allow you to select multiple values. If the options are

Cancel = Back Finish

listed with check-boxes (D), you can select any values you need. If the

options have radio buttons (Y ') next to them, you will only be able to select a single value.

After selecting the desired library types, click the Finish button.
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Libraries prompt

If you selected Libraries in the Location Selection prompt (and clicked
Next), you will be presented with the Libraries prompt.

Usage Summary

Report Selection Criteria (continued)

[~ Sample Library L (libOL)
[~ Sample Library 2 0

This lists the available libraries.

Some reports will allow you to select multiple values. If the options are

listed with check-boxes (D), you can select any values you need. If the
options have radio buttons (') next to them, you will only be able to

Libraries:

select a single value.

After selecting the desired libraries, click the Finish button.

Select all Deselect 2l

Cancel < Back Finish

Locations prompt

If you selected Locations in the Location Selection prompt (and
Usage Summary
Report Selaction Critriz (confinuz) clicked Next), you will be presented with the Locations prompt.

[T Sample Location 1 {locdl}

[T Sample Location 2§

I sample Lacation 3 c3) This lists the available locations.

Some reports will allow you to select multiple values. If the

options are listed with check-boxes (D), you can select any
values you need. If the options have radio buttons () next to

Locations:

them, you will only be able to select a single value.

After selecting the desired locations, click the Finish button.

Select all Deselect all

Cancel =Back Finish
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Common Tasks

How to Run a Report (One Time)

1.

Locate the desired report in the portal.
(We'll use the Usage Summary report as an example)

Click the report’s Run with Options button ( P’)

[@F SoE - UsagE Oy SEsson T g MOre. .
[@|p Gale - Usage Summary B8 Mare...

Specify the desired format and prompt options.
(See Report Run Options)

Click the Run button to launch the report viewer.

Run \ﬂ_n)

If you are running the report using saved prompts, the report will begin running immediately. If
you selected the option to Prompt for values, you will be presented with the prompt screen.

(See Common Report Prompts).

After completing the appropriate prompts, click the Finish button to start running the report.

Finish [%

How to E-mail a Report (One Time)

Some large reports may take several minutes to run. Instead of waiting for them to display in the

interactive window, you may choose to have these reports run in the background and the portal will

deliver them to you by e-mail when they are complete.

1.

Locate the desired report in the portal and run it according to the steps in How to Run a Report.

2. After you click the Finish button, you will see the following status message:

‘Your report is running.
8 Instesd of waiting, yvou can select a delivery

method to run the report in the background.
Select 5 delivery method,

Cancel

3. Click the Select a delivery method link.
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4. You will be prompted to select a delivery method. Click the E-mail Report link.

Your report is running.

% Instead of waiting, you can set it to run in the
background with one of the following delivery

options:

I;;u Save Report
@ Save as Report View
[ Email Repar

)

Cancel

5.

6.

7.

How

Enter your e-mail address (you may specify multiple addresses in the To: and CC: lines). You may

also edit the Subject line and add text to the main body of the message.

Check the Attach the report box.

Attach the report

iy

Click the OK button to return to the main window.

DK‘{D

to Create a Report View
1. Locate the desired report in the portal.
(We'll use the Usage Summary report as an example)

2. Click the Report View icon

g I adie = USIUE Uy SESSUTT TS |§I "4 u: Eéj |1 ] =
@k Gale - Usage Summary e E%f More




3. Give the report view a meaningful name. You may also give it a description and a screen tip
if desired.

Name:

Report View of Gale - Usage Summary

Description:

Screen tip:

4. Under Location, click the Select My Folders link

Location:

Select another location...  Select My Fu:ulderqb

If you fail to do this, your report view will not be properly saved.

5. Click the Finish button to save the report view

Finish ‘{b

How to Save Prompts in a Report View

1.

If you haven’t already done so, first create a report view of the desired report.
(See How to Create a Report View)

Locate the desired report in your My Folders tab.
(We’ll use the Report View of Gale - Usage Summary report view as an example)

Click the Properties button for the report view.

[ %I Report View of Gale - Usage Summary April 7, 2009 4:58:41 PM P More...

Select the Report View tab

General Report viey Permissions
Specify the oroperfics for t;@ niry

Under Prompt Values, uncheck the Prompt for values box, then click the Set link.

Prompt values:
Mo values saved

Set.
E\[mmpt for walues

Set the prompts to the desired values

(See Common Report Prompts)
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7. Click the Finish button to return to the report view properties page.

8.

Finish {r_n)
Click the OK button to save your changes.

DK\[b

How to Schedule a Report to Run Recurrently

1.

If you haven’t already done so, first, create a report view of the desired report.

(See How to Create a Report View)

Note: If you want multiple schedules for a given report, you’ll need to create a separate report

view for each schedule.

Locate the desired report in your My Folders tab.

(We’ll use the Report View of Gale - Usage Summary report view as an example)

Click the Schedule icon.

[l P Report View of Gale - Usage Summary

April 7, 2009 3:57:44 PM

bE@HDL

Specify the details of the schedule

] Dxsstsie the scheduie

of e 1 (s Apr T, 2009 m-

4 131 PM =3

a. Disable the schedule — Select this if you wish to define the schedule, but not let it run

yet.

b. Start—The schedule will not begin until after this date

c. End—The schedule will stop running after this date
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d.

e.

Frequency — Select the frequency with which you want the report to be run. For

example, if you want the report to run on the 5™ of each month, you would set the

frequency of the schedule like this:

Frequency:
Select the frequency by dicking on a link.

By Day By Week ¥ By Month By Year By Trigger
O The of every month(s)
®pay|5 ¥|ofevery|l month(s)

Options — Click Override the default values if you would like to change the output

format (see Format) or set up e-mail delivery for the scheduled report.

E-mail Delivery

i. Check Send a link to the report by email and click Edit the options ...

Delivery:
5

o)

Save the report

[ Print the report
Printer location:

Send a link to the report by email  Edit the options. .
0 recipients :\I ?

Select a printer...

ii. Enter your e-mail address (you may specify multiple addresses in the To: and CC:

lines). You may also edit the Subject line and add text to the main body of the

message.

iii. By default, the e-mail will contain a link to your report. Clicking the link will open

the report in your Web browser.

Include a link to the repart
[ ] #ttach the report
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iv. If you would rather receive your report as an attachment, uncheck Include a link
to the report and check Attach the report instead.

[] Include a link to the report
Attach the report

f. Prompt values - If you have saved prompt values in the report view, you can leave the
Override the default values box unchecked to use the saved prompts. Otherwise, you
must check this box and click the Set link to set the prompt values for this schedule.

Prompt values

Override the default values

Mo values saved
Set, E

(See Common Report Prompts)
Then click the Finish button to save the prompt values.

Finish [%

Note: If there are no prompt values specified for the schedule, the report will fail to

run.

5. Click the OK button to save the schedule

DI{({F_n)
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